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Introduction
The Quality Improvement Toolkit
This Quality Improvement (QI) Toolkit is made up of modules that are designed to support your practice to make easy,
measurable and sustainable improvements to provide best practice care for your patients. The Toolkit will help your
practice complete Quality Improvement (QI) activities using the Model for Improvement.
Throughout the modules you will be guided to explore your data to understand more about your patient population
and the pathways of care being provided in your practice. Reflections from the module activities and the related data
will inform improvement ideas for you to action using the Model for Improvement.
The Model for Improvement uses the Plan-Do-Study-Act (PDSA) cycle, a tried and tested approach to achieving
successful change. It offers the following benefits:
•

it is a simple approach that anyone can apply

•

it reduces risk by starting small

•

it can be used to help plan, develop and implement change that is highly effective.

The Model for Improvement helps you break down your change into manageable pieces, which are then tested to
ensure that the change results in measurable improvements, and that minimal effort is wasted.
There is an example of how to record alcohol status using the Model for Improvement and a blank template for you to
complete at the end of this module.
If you would like additional support in relation to quality improvement in your practice please contact Brisbane South
PHN on optimalcare@bsphn.org.au
This icon indicates that the information relates to the ten Practice Incentive Program
(PIP) Quality Improvement (QI) measures.
Due to constant developments in research and health guidelines, the information in this document will need to be
updated regularly. Please contact Brisbane South PHN if you have any feedback regarding the content of this document.
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Mental health
Mental health introduction toolkit for general practice
This toolkit is designed to assist you to review your patients who may be affected by a mental health condition. This is
part of the introduction module with sub topics available. It is suggested that you work through this toolkit and then
identify the sub topic to focus on.
Key topics included in this toolkit are:
•

overview of mental health in the Brisbane south region

•

understanding your patient mental health profile

•

comparing your patient profile with other practices via Brisbane South PHN’s benchmark report

•

data cleansing – ensure all patients that are coded with mental health have been marked active/inactive,
indication with no diagnosis

•

co-morbidities

•

preventative health measures including:
o

family & social history

o

blood pressure

o

weight, height & BMI

o

nutrition

o

smoking

o

alcohol status

o

physical activity

•

Medicare item numbers for mental health patients including how to complete templates

•

tools to assist with diagnosis (K10, depression scale etc)

•

recalls/reminders

•

appropriate care co-ordination in the practice (who does what)

•

policy & procedures (including mental health policy strategy), anti-bullying in the workplace, support for staff
when dealing with stressful situations, GP self-care

•

referral pathways and support options

•

resources.

Key goals/objectives for using this toolkit
This toolkit is to be used in general practice to:
•

identify those patients in your practice at risk of mental illness (e.g. those with chronic disease)

•

develop a register of patients with a mental health condition to facilitate better continuity of care (reminders,
recalls)

Brisbane South PHN
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•

have the ability to better manage the physical health of patients with a mental health condition

•

improve medication management through review against clinical guidelines (e.g. appropriate use of
medications, risk management)

•

identify patients eligible for mental health and other funding streams.

What is a mental illness?
About one in five Australians will experience a mental illness, and most of us will experience a mental health problem
at some time in our lives.
A mental illness is a health problem that significantly affects how a person feels, thinks, behaves, and interacts with
other people. It is diagnosed according to standardised criteria.
A mental health problem also interferes with how a person thinks, feels, and behaves, but to a lesser extent than a
mental illness.
Mental health problems are more common and include the mental ill health that can be experienced temporarily as a
reaction to the stresses of life.
Mental health problems are less severe than mental illnesses, but may develop into a mental illness if they are not
effectively dealt with.
Mental illnesses cause a great deal of suffering to those experiencing them, as well as their families and friends. There
are a number of risk factors relating to mental illness including:
•

biological factors, such as genetics and physical illness

•

lack of support network

•

external factors such as job loss, relationship breakdown, family conflict, and financial and environmental
stressors.

Furthermore, these problems appear to be increasing. According to the World Health Organization, depression will be
one of the biggest health problems worldwide by the year 2020.1

Types of mental illness
Mental illnesses are of different types and degrees of severity. Some of the major types are:
•

depression

•

anxiety

•

schizophrenia

•

bipolar mood disorder

•

personality disorders

•

eating disorders

The most common mental illnesses are anxiety and depressive disorders.

1

https://www1.health.gov.au/internet/publications/publishing.nsf/Content/mental-pubs-w-whatmen-toc~mental-pubs-wwhatmen-what
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Treatment of mental illness
Most mental illnesses can be effectively treated. Recognising the early signs and symptoms of mental illness and
accessing effective treatment early is important. The earlier treatment starts, the better the outcome.
Episodes of mental illness can come and go during different periods in people’s lives. Some people experience only
one episode of illness and fully recover. For others, it recurs throughout their lives.
Effective treatments can include medication, cognitive and behavioural psychological therapies, psycho-social support,
avoidance of risk factors such as harmful alcohol and other drug use, and learning self-management skills.
People with mental health conditions often experience a disproportionately higher burden of physical disease.
Treatment options for physical help to assist with mental illness include reviewing nutrition, exercise, preventative
health care (screening) and addressing risk factors such as smoking, alcohol use and drug use (prescribed and illicit).

Mental health statistics
The National Survey of Mental Health and Wellbeing: Summary of Results, 2007 demonstrates the following:

2

•

Depression: One in seven Australians will experience depression in their lifetime. One in 16 Australians are
currently experiencing depression.

•

Affective disorders: Fifteen per cent of Australians aged 16 to 85 have experienced an affective disorder. This
is equivalent to 2.83 million people today. In the last 12 months, 6.2% of Australians aged 16 to 85 have
experienced an affective disorder. This is equivalent to 1.16 million people today.

•

Anxiety: One in seven Australians are currently experiencing an anxiety condition. One quarter of Australians
will experience an anxiety condition in their lifetime and 26.3% of Australians aged 16 to 85 have experienced
an anxiety disorder. This is equivalent to 4.96 million people today.

•

Support-seeking appears to be growing at a rapid rate, with around half of all people with a condition now
getting treatment. The estimated population treatment rate for mental disorders in Australia increased from
37% in 2006–07 to 46% in 2009–10.

•

Women are more likely than men to experience depression and anxiety. One in six women will experience
depression in their lifetime compared with one in eight men. One in three women will experience an anxiety
condition in their lifetime compared with one in five men

•

One in eight Australians is currently experiencing high or very high psychological distress. In 2017-18, around
one in eight (13.0% or 2.4 million) Australians aged 18 years and over experienced high or very high levels of
psychological distress, an increase from 2014-15 (11.7%). Between 2014-15 and 2017-18, rates of high or very
high psychological distress remained reasonably stable across most age groups, with the exception of an
increase in 55-64-year-old women (from 12.3% to 16.9% respectively). 2

https://www.abs.gov.au/AUSSTATS/abs@.nsf/Lookup/4326.0Main+Features32007?OpenDocument
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Mental health in the Brisbane south region
In 2017 Brisbane South PHN commenced a planning process to create a regional mental health, suicide prevention,
and alcohol and other drug strategy and roadmap for 2019-2022.
The final Brisbane South Mental Health, Suicide Prevention, and Alcohol and Other Drug (MHSPAOD) Strategy 20192022 and roadmap articulates a system-wide vision for future provision of services in Brisbane south, which has been
developed based on information from the 2018 Needs Assessment and through extensive consultation with
consumers, carers, the public sector, private and non-government service providers and primary care.
A key driver for the development of the MHSPAOD Strategy is Brisbane South PHN’s remit to improve the
coordination of services across the community and:
•

meet the increasing needs of the Brisbane South PHN population, and in particular, support the provision of
localised services that provide access to underserviced populations

•

support the provision of evidence-based, appropriate and effective care

•

increase accessibility and equity of service provision for the community, and in particular, support the
provision of the right services, in the right location, at the right time

•

improve integration and continuity of care for clients between providers and health delivery partners such as
General Practitioners (GPs), not-for-profit organisations and hospital and health services

•

better align with Brisbane South PHN’s role as a commissioner

•

drive value for money and outcomes-based results through robust agreements with service providers.

The MHSPAOD Strategy and roadmap will guide the collaborative approach to planning and service for the region, as
well as the recommissioning of primary mental health, suicide prevention, and alcohol and other drug treatment
services by Brisbane South PHN.4

3

https://www.uq.edu.au/news/article/2017/04/uq-researchers-play-key-role-world-health-day
https://bsphn.org.au/wp-content/uploads/2019/03/Brisbane-South-Mental-Health-Suicide-Prevention-and-Alcohol-and-OtherDrug-MHSPAOD-Strategy-2019-2022.pdf
4
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Activity 1 - Understanding your patient mental health
profile
Using CAT4 to identify your practice’s mental health patients
There are a few searches that you can do on CAT4 to identify and manage patients with mental health conditions.
Correctly identifying and coding people who have mental health conditions allows for regular monitoring and
treatment optimisation and is vital for automatic software prompts, e.g. medications which may need monitoring
(such as lithium) or compliance (such as depo-antipsychotic medication), or overuse/underuse of medications.

Data Review – patients with indicated mental health with no diagnosis
The ‘Indicated Mental Health with no diagnosis’ report will display the likelihood of a mental health condition based
on a mental health medication or a mental health care plan being recorded in the patient record without a diagnosis.
Any mental health diagnoses included in the existing CAT4 reports/filters is considered, regardless of whether the
diagnosis is marked as active or inactive in the patient record.
•

Red = likely

•

Orange = possible

RED:
Has a Mental Health Care Plan MBS item number claimed (2700, 2701, 2715, 2717 or
previous 2702 or 2710)

ORANGE:
On a mental health
medication

The report displays:
•

MH medication

•

MH MBS item numbers

•

chronic disease co-morbidities/risk factors

•

other MH risk factors.

Identifying patients with a mental health condition
You are able to search for patients with mental health disorders under conditions. These include:
•

mental health, including high prevalence (anxiety, depression), low prevalence (schizophrenia and bipolar)

•

MH – degenerative, including dementia

•

MH – development, including ADHD and ASD

•

MH – other including depression during and after pregnancy.

Brisbane South PHN
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Mental Health Summary Report Card
The MH Summary Report Card is available under the 'Standard Reports' tab. This report provides a snapshot of GP
data relating to mental health. It is designed to encourage GPs to review and update their management strategies for
patients diagnosed with mental health disorders, specifically schizophrenia, in their practices.

Identify all active patients with at least one chronic condition who may be eligible for a
medication review
Patients with chronic conditions are often taking multiple medications and would benefit from a review of their
medications. This will ensure appropriate medications are prescribed and helps to reduce side effects and other
medication-related risks.

Identifying patients via risk factors
The 'Risks Factors' filter allows practices to filter for patients using the risk factors of smoking, alcohol (drinker and
high risk), drug use, and obesity. The risk factors are defined as:
•

smoking – daily or irregular

•

alcohol – drinker: drinks alcohol

•

alcohol – drinker high risk: 2 or more drinks on a regular occasion or more than 4 drinks on any occasion

•

medication/drug use – coded diagnosis in patient record

•

obesity – BMI of 30 or more.

Please note: select mental health under the conditions section of CAT4 to search on patients with a known mental
health condition.

Identifying patients who may be eligible for a mental health treatment plan
The GP mental health treatment plan (MHTP) provides a structured framework for GPs to undertake early
intervention, assessment and management of patients with mental disorders, as well as providing referral pathways to
clinical psychologist and allied mental health service providers.
Please note: this report will produce a large number of patients. You may wish to filter the search by including the
number of visits per year.

Brisbane South PHN
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Identifying patients with co-morbidities
The co-morbidities report shows patients with a mental health condition and at least one of the following conditions:
•

diabetes

•

respiratory

•

cardiovascular

•

musculoskeletal

•

renal impairment.

The data is displayed in a pie chart and lists patients with 1, 2, 3, 4 and more than 4 conditions.

Medication filtering
This search is useful to help to ensure medication lists are up to date and assist with appropriate medication
prescribing. Medications are flagged as true if they are on the patient's current medication list. The collection process
does not make any decisions about whether a medication should be removed from the current medication list. The GP
is responsible for making sure the list of medications is accurate.

Brisbane South PHN
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Activity 1.1 – Data collection from CAT4
The aim of this activity is to collect data to identify patients at risk of a mental health condition and also assist
with the management of patients with a mental health condition
Complete the below table by collecting data from your CAT4 Data Extraction Tool.
Note - Instructions on how to extract the data is available from the CAT4 website. Number of patients with a mental
health condition or Indicated mental health with no diagnosis or Number of patients with a mental health condition
who may be eligible for a home medication review or Number of patients who have had a mental health treatment
plan completed in the past 12 months or Number of patients on medications
Description

Total number of
active patients as
per RACGP criteria (3
x visits in 2 years)

1.1a

Number of active patient population

1.1b

Number of active patients (i.e.: 3 x visits in 2 years)

Total number of
active patients

See instructions in link below.
Identify active patients with at least 3 visits in the last 2
years.
1.1c

Number of patients with a mental health condition

1.1d

Number of patients with indicated mental health but no
diagnosis

1.1e

Number of patients with a mental health condition who
may be eligible for a home medication review
(on the instructions, select condition as mental health)

1.1f

Number of patients who have had a mental health
treatment plan completed in the past 12 months

1.1g

Number of patients with a mental health condition on
antidepressant medications

1.1h

Number of patients with a mental health condition on
antipsychotic medications

1.1i

Number of patients with a mental health condition on
mood stabilisers

1.1j

Number of patients with a mental health condition on
pain relief medication

Please note: the RACGP defines active as 3 x visits in 2 years. This search criteria does not capture those patients who
may come in for screening every 2 years, or twice in 2 years e.g. flu vaccine, hence the option to look at all active
patients.

Brisbane South PHN
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Reflection on Activity 1.1:

Practice name:

Date:

Team member:

Activity 1.2 – Reviewing your practice mental health profile
Complete the checklist below to review your practice’s mental health patients ‘at risk’ and diagnosed.
Description
After completing activity 1.1, are
there any unexpected results
with your practice’s mental
health profile?

Status

Action to be taken

 Yes: see actions to be taken.

Please explain: (e.g. higher number
of patients with mental health
condition than expected or only a
low percentage of patients with
mental health condition have a MH
treatment plan.)

 No: continue with activity.

How will this information be
communicated to the practice
team?

After reviewing your practice’s
mental health profile, are there
any changes you would like to
implement in the practice to help
manage patients over the next 12
months?

Brisbane South PHN

 Yes: see actions to be taken.

 No: you have completed this activity.

Refer to the Model for
Improvement (MFI) and the
Thinking part at the end of this
document.
Refer to the Doing part - PDSA of
the Model for Improvement (MFI)
to test and measure your ideas for
success.
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Reflection on Activity 1.2:

Practice name:

Date:

Team member:

Activity 1.3 – Mental health measures on benchmark report
The aim of this activity is to review your practice’s data dashboard on the monthly benchmark report provided
by Brisbane South PHN.
You will need your practice’s benchmark report to complete this information.

Brisbane South PHN
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Description

Percentage

1.3a

Active population with coded mental health diagnosis

1.3b

Active patients with a mental health condition and a mental health treatment plan

1.3c

Active patients with a mental health condition and a mental health treatment plan
review

1.3d

Active patients with a mental health condition and a mental health consult

1.3e

Active patients with a diagnosis of anxiety

1.3f

Active patients with a diagnosis of depression

1.3g

Active patients with a diagnosis of bipolar

1.3h

Active patients with a diagnosis of schizophrenia

Reflection on Activity 1.3:

Practice name:

Date:

Team member:

Activity 1.4– Reviewing your practice mental health profile on the benchmark report
Complete the checklist below to review your practice’s mental health profile from your benchmark report.
Description
After completing activity 1.3, are
there any unexpected results
with your practice’s mental
health profile?

Brisbane South PHN

Status

Action to be taken

 Yes: see actions to be taken.

Please explain: (e.g. a low
percentage of mental health
patients have a mental health
consult).

 No: continue with activity.

How will this information be
communicated to the practice
team?
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Description
Is your practice mental health
patient profile similar to other
practices in the Brisbane South
region (compare information
from Benchmark report)?

Status

Action to be taken

 Yes: continue with activity.

Outline the differences – (e.g. our
practice has a lower percentage of
patients with a mental health
diagnosis than other practices).

 No: see actions to be taken.
How will this information be
communicated to the practice
team?

After reviewing your practice’s
mental health profile, are there
any changes you would like to
implement in the practice to help
manage patients over the next 12
months?

 Yes: see actions to be taken.

 No: you have completed this activity.

Refer to the Model for
Improvement (MFI) and the
Thinking part at the end of this
document.
Refer to the Doing part - PDSA of
the Model for Improvement (MFI)
to test and measure your ideas for
success.

Reflection on Activity 1.4:

Practice name:

Date:

Team member:

Brisbane South PHN
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Activity 2 – Building your practice mental health register
Coding is simply a process of using an agreed standardised descriptor to store data as a series of numbers or letters.
There are multiple ways clinical staff may enter a patient’s diagnosis in practice software. Some will type this information
directly into the patient progress notes or enter this information as free text in the ‘reason for encounter’ or ‘diagnosis
field’. This process is called free texting or un-coded diagnosis. Free text is not easily searchable in any database by the
clinical software or third-party software (e.g. extraction tools).
If GPs require further information to describe the clinical
condition, then include this in a descriptor field. If a particular
coded diagnosis is not available, contact your software provider
(see example image).
The recommended process is to use a diagnosis from the dropdown boxes provided in the clinical software. This is a coded
diagnosis. If all clinical staff within the practice use the same
codes to identify a diagnosis then it is easier to search for
particular conditions.
It is important to ensure your coding is consistent and agreed
upon by all clinical staff in the practice, and diagnostic criteria for
mental health are uniform. The following activity will guide you
through this process.
This resource highlights the benefits of having good quality data within your clinical software.

Time required to…

Good Data

Poor Data

Write a referral*

5 minutes

Up to 10+ minutes

Upload a shared health
summary to the My Health
Record*

30 seconds

Up to 5+ minutes

Write & print a Health
Summary*

30 seconds

Up to 5+ minutes

*These are approximate estimations and will vary depending on the quality of data and software within your individual practice.
These figures should be used as a guide.
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Advantages and disadvantages of labelling a mental illness
If someone has a mental health diagnosis it is important it is recorded correctly so that the treating team are aware for
safety and to allow correct treatment (and to lessen stigma). Any diagnosis should be discussed with the person. Just
as we would record a physical health diagnosis, a mental health condition should recorded if it has been diagnosed. If
preferred, it may be marked as confidential, or inactive if no longer of concern, and people may choose not to upload
it to My Health Record if desired.

Activity 2.1 – Determine terms of consistent coding
The aim of this activity is for the clinical team to agree on consistent coding to be used within the practice.
Description

Status

Action to be taken

Are relevant practice team
members aware of the
importance of quality data
including using consistent coding
(avoiding free text)?

 Yes: continue with this activity.

Organise a practice team meeting to
discuss how to develop a clinical
coding policy for your practice.

 No, see action to be taken.

This may be a specific area that the
practice is working on, to make it
task easier.

Have you agreed on accepted
terminology of mental health
conditions from the drop-down
lists in your practice software?

 Yes: continue with this activity.

Source list of clinical codes already
available in current clinical software.

 No, see action to be taken.

Source list of clinical codes from
CAT4 clinical audit tool.

From these two lists agree on clinical
codes for mental health to be used
within practice.
_____________________________
_____________________________
_____________________________
_____________________________
Have your agreed clinical codes
been included in your practice
policy?

 Yes: continue with this activity.

Record agreed clinical codes in
practice policy manual.

 No, see action to be taken.
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Description
Are practice team members
aware of how to enter diagnoses
in clinical software using agreed
mental health conditions?

Status

Action to be taken
See instructions for Best Practice
users.

 Yes: continue with this activity.

 No, see action to be taken.
See instructions for Medical Director
users.
After reviewing your practice’s
clinical coding guidelines, are
there any changes you would
like to implement in the practice,
to help manage patients, over
the next 12 months?

 Yes, see actions to be taken to help
set your goals.

 No, you have completed this
activity.

Refer to the Model for Improvement
(MFI) and the Thinking part at the
end of this document.
Refer to the Doing part - PDSA of the
Model for Improvement (MFI) to test
and measure your ideas for success.

Reflection on Activity 2.1:

Practice name:

Date:

Team member:
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Activity 2.2 – Cleaning up un-coded conditions in your practice software
You can clean up un-coded conditions that have been recorded in your practice software. Cleaning up un-coded items
makes it easier to perform database searches and manage third-party clinical audit tools.
Instructions for cleaning up un-coded conditions in Best Practice

It is also possible to clean up un-coded conditions that
have been recorded in the Past History section of
Best Practice. This can assist when performing
database searches or using 3rd party Clinical Audit
tools.
This cleanup is done via the BP Utilities function.
Select Start > Programs > Best Practice Software >
Best Practice > BP Utilities. Select your user name
from the drop-down list. You will only have access to
this function if you have sufficient user permissions.

Double click on the
icon.
The Past History cleanup screen will
appear.
Un-coded Past History is a current
list of all past history entries entered
into the database (usually from a
conversion or free texted), and the
Conditions column is the complete
list of coded conditions entered into
Best Practice.
On the left-hand side, highlight the
item that will be merged to a coded
condition. On the right-hand side,
enter the coded condition into the
keyword search field. Highlight the
condition to merge to, then select
the replace button.
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Instructions for cleaning up un-coded conditions in Medical Director
Medical Director provides a simple utility in HCN Maintenance that enables you to easily find un-coded past medical
history items, and either link them to a coded item or replace them with the correct coded item.
1.
2.

Double click the HCN Maintenance icon
to open HCN Maintenance.
Select Medical Director Clinical in the list of Database Tasks on the left of the window.

3.

Double click the Diagnosis Coder icon

The left-hand panel of this screen contains all the un-coded diagnosis entries in the Past Medical History database. The
right-hand panel displays coded entries to pair-up with your un-coded entries. Note that the right-hand panel is
initially empty, but as you type into the text box above it, a list of items is generated underneath.
Simply highlight the entry on the left and the one you want to link or replace it with on the right, and then click either
the Link or Correct button.
The Link button will attach the code for that diagnosis to the coded entry on the right. The Correct button will change
the diagnosis on the left to that on the right (i.e. if the word was misspelled).

Reflection on Activity 2.2:

Practice name:

Date:

Team member:
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Activity 2.3 – Marking mental health condition as active/inactive
It is important when completing each patient’s progress notes, to mark the consult with an appropriate
condition. PLEASE NOTE: if a mental health condition is marked as ‘active’ the patient will be included in any
appropriate reports produced on CAT4. If the condition is marked ‘inactive’, they will not be included in CAT4
reports. The clinical team should understand the importance of marking conditions as active or inactive.
The aim of this activity is to ensure all the clinical team within the practice understand the importance of marking
conditions as active or inactive.
Description

Status

Are relevant practice team
members aware of the
importance of marking
conditions or reason for visits as
active or inactive?

 Yes: continue with this activity.

Are relevant practice team
members aware that they can
mark sensitive information as
confidential?

 Yes: continue with this activity.

Action to be taken
Include in the next clinical team
meeting/s the importance of marking
patient’s history and/or reason for
visit as active or inactive.

 No, see action to be taken.

 No, see action to be taken.

Does your practice policy and
procedure manual include a
section on marking patient past
history and/or conditions as
active or inactive?

 Yes: continue with this activity.

Are practice team members
aware of how to enter
active/inactive in your practice’s
clinical software?

 Yes: continue with this activity.

Include in the next clinical team
meeting/s some information on
marking patient’s history and/or
reason for visit as confidential. This is
generally only done for very sensitive
information.

Update policy and procedure
manual.

 No, see action to be taken.

See instructions for Best Practice
users.

 No, see action to be taken.
See instructions for Medical Director
users.
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Description

Status

Action to be taken

After reviewing your practice’s
active/inactive conditions
processes, are there any changes
you would like to implement in
the practice, to help manage
patients over the next 12
months?

 Yes, see actions to be taken to help
set your goals.

Refer to the Model for Improvement
(MFI) and the Thinking part at the
end of this document.

 No, you have completed this
activity.

Refer to the Doing part - PDSA of the
Model for Improvement (MFI) to test
and measure your ideas for success.

Reflection on Activity 2.3:

Practice name:

Date:

Team member:

Instructions for adding active, inactive or confidential to Best Practice notes
1. In the past medical history screen, select the condition in the search field.
2. Then tick either Active or Inactive
3. You may wish to remove from sending to My Health Record
4. Mark item as Confidential if extremely sensitive.
5. Select Save to complete.

The 'Confidential' box marks history items as
confidential and these will not appear in materials
such as Referral Letters and Reports. This feature is
intended for very sensitive personal health
information only.
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Instructions for adding active, inactive or confidential to Medical Director notes
1. In the reason for contact or new history item screen, select the condition in the pick from list field.
2. Then tick Active if relevant.
3. In the reason for contact screen, you can choose to save in past medical history for significant problems.
4. Mark item as Confidential if extremely sensitive.
5. Select ok to complete.

By default, the procedure is marked as Active. To change this, clear the Active check box

Activity 2.4 – Confirming the right patients are on the register
Patients with mental health diagnosis are central to the patient register. The aim of this activity is to look at
patients with indicated mental health with no diagnosis reported.
Instructions on how to conduct this search can be found here.
Description of patient
list

Patient information is
updated in clinical software
where relevant

Patient information is
included in mental health
register where relevant

Completed

Active patients with
indications for mental
health with NO diagnosis
The "Indicated mental
health with no diagnosis"
report will display the
likelihood of a mental
health condition based on
a mental health
medication or a mental
health care plan being
recorded in the patient
record without a
diagnosis.
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Reflection on Activity 2.4:

Practice name:

Date:

Team member:

Practice decision point
It is recommended that you have a practice meeting to review the data collection table results and determine
any action that needs to be taken. The table below will help guide you through this process.

Activity 2.5 – Distribute list of patients with indicated mental health with no diagnosis to
individual GPs
Description
After completing
activity 1.1, note how
many active patients
have indicated
mental health with
no diagnosis.

Action to be taken

Number: _________________________________________________________________

(e.g. coding issue, information inconclusive etc.):

Is there an
explanation for this
result?

Have you distributed
lists to individual GPs
for review and
update of their
diagnosis?

_______________________________________________________________________
_______________________________________________________________________
_______________________________________________________________________

 Yes
Ensure you follow up in a week’s
time to receive the reviewed reports
back from the GP.

 No
Follow the instructions to complete this.

You have completed this activity.

Please note: CAT 4 assigns providers in the following ways:
Best Practice: Best Practice uses the 'Usual Doctor' field in the patient demographics as the patients assigned provider.
Where a 'Usual Doctor' is not selected, patients will be assigned to a particular provider based on which provider they
were most frequently seen by in recent consultations. Patients will be assigned to the active provider who saw them
for the highest number of consultations in the previous 18 months.
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Medical Director: Where there is more than one provider in the practice, patients will be assigned to a particular
provider based on which provider they were most frequently seen by in recent consultations. Providers that are active
will be given priority over providers that have been made inactive. Patients will be assigned to the provider who saw
them for the highest number of consultations in the previous 18 months.

Reflection on Activity 2.5:

Practice name:

Date:

Team member:

Activity 2.6 – Build a system to maintain your mental health patient register:
In a team meeting, discuss the following:

Topic
Maintaining the database.

Question to consider

Action to be taken

Appoint a ‘database manager’ who will
review the register, perform the
searches as outlined in the toolkit and
report back to the practice.

Who will this be?

Will this person require training?

Yes  No 
If yes, who will provide it and when
will it take place?

How much ‘protected time’ will this
person require to maintain the
database?
Is that amount of time reasonable and
will it fit within their workload?
Implement a system to ensure this
continues when the ‘database
manager’ is away and/or leaves.
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Topic

Question to consider

Action to be taken
Yes  No 

Do they also require training?

If yes, who will provide it and when
will it take place?

How will you document your system for
maintaining the database so the system
works even when the database
manager is away?
i.e. in policies and procedures
A system for ensuring new
information is gathered and
recorded.

How will new cases be identified or
existing cases updated when there is a
change in diagnosis?
How will the information reach the
database manager and be coded
appropriately?
How will GPs notify the ‘database
manager’ of changes to patient
information?

Reviewing the database to
confirm validity.

How frequently will the database
manager check the quality of the
information on the database?
Are all patients still active?

Yes  No 

Are clinicians actively entering
diagnosis correctly?

Yes  No 

Please note: the definition of “database” is referring to the clinical software program that is used by your practice. (for
e.g.: Medical Director, Best Practice, Genie etc)
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Reflection on Activity 2.6:

Practice name:

Date:

Team member:
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Activity 3. Identifying patients with mental health
conditions and other chronic medical conditions
Activity 3.1 –Data collection from CAT4
The aim of this activity is to collect data to identify patients with mental health and at least one other chronic
medical condition
Mental illnesses are associated with a higher risk of obesity, diabetes and cardiovascular disease. 5 Identifying
this comorbidity allows for more effective management of both physical and mental health. Chronic health
problems can also increase the likelihood of a mental health problem, or confound efforts to better manage a physical
health problem.
Complete the below table by collecting data from your CAT4 Data Extraction Tool. Note - Instructions on how to
extract the data is available from the CAT4 website: co-morbidities OR chronic conditions.
Description

Total
number of
active
patients as
per RACGP
criteria (3 x
visits in 2
years)

3.1a

Number of patients with a mental health condition and 1 other chronic
medical condition

3.1b

Number of patients with a mental health condition and 2 other chronic
medical conditions

3.1c

Number of patients with a mental health condition and 3 other chronic
medical conditions

3.1d

Number of active patients with a mental health condition and diabetes
(select Mental Health yes & Diabetes Yes and recalculate)

3.1e

Number of active patients with a mental health condition and
cardiovascular disease (select Mental Health yes & Cardiovascular yes)

Total
number of
active
patients

Please note: You can search lists by individual providers and provide to them to identify patients with multiple chronic
conditions.

5

https://www.thelancet.com/pdfs/journals/lanpsy/PIIS2215-0366(19)30132-4.pdf
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Reflection on Activity 3.1:

Practice name:

Date:

Team member:

Activity 3.2– Reviewing your patients with multiple chronic medical conditions
Complete the checklist below to review your patients with multiple chronic medical conditions.
Description
After completing activity 3.1 are
there any unexpected results
with your patients’
comorbidities?

Status
 Yes: see actions to be taken.

 No: continue with activity.

Action to be taken
Please explain: (e.g. higher number
of patients with mental health
condition and 3 other chronic
medical conditions).

How will this information be
communicated to the practice
team?

After completing activity 3.1, do
you have any unexpected results
about the number of patients
with a mental health condition &
diabetes?

 Yes: see actions to be taken.

Consider completing a Diabetes
Cycle of Care. Refer to MBS online
for criteria.

 No: continue with activity.
Information to assist with patients
with a mental health condition &
diabetes is available from Diabetes
Australia.

Refer to Brisbane South PHN’s QI
Toolkit – Chronic Conditions Diabetes.
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Description
After completing activity 3.1, do
you have any unexpected results
about the number of patients
with a mental health condition &
cardiovascular disease?

Status

Action to be taken

 Yes: see actions to be taken,

Consider a medication review,

 No: continue with activity,

Consider recalling the patient to
check if they are meeting
treatment goals.

Refer to Brisbane South PHN’s QI
Toolkit – Chronic Conditions –
Cardiovascular,

After reviewing your practice’s
comorbidities profile, are there
any changes you would like to
implement in the practice to help
manage patients over the next 12
months?

 Yes: see actions to be taken.

 No: you have completed this activity.

Refer to the Model for
Improvement (MFI) and the
Thinking part at the end of this
document.
Refer to the Doing part - PDSA of
the Model for Improvement (MFI)
to test and measure your ideas for
success.

Reflection on Activity 3.2:

Practice name:

Date:

Team member:
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Activity 4. Preventative health for patients with a mental
health condition
Looking after physical health is important for everyone, but it can be an extra challenge for people who have a mental
illness.
This may be related to the symptoms of the illness or the side-effects of medication. It may be due to smoking, not
getting enough exercise, or other lifestyle factors. Physical health problems can also get overlooked when everyone’s
focus is on looking after the mental health condition.
Whatever the reasons, people affected by mental illness often have some of the following problems:
•

weight gain

•

high blood pressure

•

high cholesterol

•

high blood glucose levels.

These problems may lead to heart disease, diabetes or other illnesses. Being physically and mentally healthy in day-today life can make a big difference.
The aim of this activity is to look at preventative health options for patients with a mental health condition. This will
include:
•

physical activity

•

alcohol

•

smoking

•

weight and BMI

•

other risk factors including blood pressure, BSL.

Mental health conditions and cancer screening
People with mental health conditions are also potentially less likely to participate in cancer screening. Brisbane South
PHN has a cancer screening toolkit to assist with identifying under-screened patients.

Recording risk factors in your clinical software
It is important to record activities in the correct data fields and avoid entering the activities as ‘free text’ in the
progress notes. By recording the information in the correct fields, it will:
•

improve efficiency when using your software package by reducing the amount of time needed to search for
information in the patient progress notes

•

improve consistency in how data is entered across all patients at the practice

•

allow the Pen Clinical Audit tool to extract accurate data on patients.
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Physical Activity
As defined in the most recent RACGP report supporting Australia’s physical activity and sedentary guidelines for
adults, six terms apply to this section:
•

physical activity

•

sedentary behaviours

•

metabolic equivalent (MET)

•

intensity

•

frequency

•

duration.

Physical activity is important for mental health, pain management, a range of chronic disease and also disease
prevention and health promotion.

Activity 4.1 – Data Collection from CAT4
Complete the below table by collecting data from your practice monthly benchmark report.
The aim of this activity is to collect data to determine the number of patients with their physical activity
recorded.
Description

Total
Number

4.1a

Number of active patients who have their physical
activity recorded

4.1b

Number of active patients with a mental health
condition who have their physical activity recorded

%
completed

Accreditation
target met
□ Yes □ No

Please note: As a general rule, data recording in this area is low across all practices in the Brisbane South PHN area. If
the option for data recording is not user friendly at your practice, please notify your software provider.

Reflection on Activity 4.1:

Practice name:

Date:

Team member:
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Figure: Sample snapshot of Brisbane South PHN benchmark report – mental health - management

Activity 4.2 – Understanding your practice physical activity status
The aim of this activity is to increase your understanding of the patient’s physical activity status.

Description
After completing activity 4.1, are
there any unexpected results with
your practice’s patient physical
activity status?

Status

Action to be Taken

 Yes: see actions to be taken.

Please explain: (e.g. low recording of
physical activity status,)

 No: continue with activity.

How will this information be
communicated to the practice team?
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Description
Are your practice patient measures
similar to those at other practices in
the Brisbane South region (compare
information from Benchmark
report)?

Status

Action to be Taken

 Yes: continue with activity.

Outline the differences (e.g.: we’re on
similar par to other practices, others
are doing much better than us).

 No: see action to be taken.

How will this information be
communicated to the practice team?

Do all clinicians know how to enter
physical activity status in your
practice’s clinical software?

 Yes: continue with activity.

See instructions on how to enter into
Medical Director or Best Practice.

 No: see action to be taken.
After reviewing practice physical
activity status, are there any changes
you would like to implement in the
practice, to help using practice
software, over the next 12 months?

 Yes, see actions to be taken to
help set you goals.

Refer to the Model for Improvement
(MFI) and the Thinking part at the
end of this document.

 No, you have completed this
activity.

Refer to the Doing part - PDSA of the
Model for Improvement (MFI) to test
and measure your ideas for success.

Reflection on Activity 4.2:

Practice name:

Date:

Team member:
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Entering physical activity information in the patient file in Best Practice
1. Open the patient file.

2. Select Clinical > Physical Activity Prescription.

3. Complete the physical activity by using the drop-down menu options.
4.

Click Print to save.
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Entering physical activity information in the patient file in Medical Director
1. Open the patient file.
2. Click on the Physical Activity Prescription (red person running) on the toolbar.

3. You can then complete an assessment or prescribe the patient a physical activity prescription.

Smoking and Alcohol status
In Australia, while the prevalence of smoking is declining in the general community, it remains high among people
with mental illness. Compared with the general population, people with mental illness have higher smoking rates,
higher levels of nicotine dependence, and a disproportionate health and financial burden from smoking.6
Alcohol can have a major impact on mental health. Because alcohol is a depressant, it slows the body down and
changes the chemical makeup in the brain. This has many effects. It can alter:
•

mood

•

energy levels

•

sleeping patterns

•

concentration

•

memory

•

and also increase risk of injury.

Alcohol reduces inhibitions and impacts decision making. 7

6
7

https://www.tobaccoinaustralia.org.au/chapter-7-cessation/7-12-smoking-and-mental-health
https://headspace.org.au/young-people/how-does-alcohol-affect-mental-health/
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Activity 4.3 – Data Collection from CAT4
Complete the below table by collecting data from your PIP QI measures from your practice monthly
benchmark report. You can also collect information from CAT4. The recipe is available here (change condition
to mental health)

The aim of this activity is to collect data to determine the number of patients who have their smoking and alcohol
status recorded.
Description

Percentage

4.3a

Number of active patients aged 15+ years with
smoking status recorded as current smoker

4.3b

Number of active patients aged 15+ years with an
alcohol consumption status recorded

4.3c

Number of active patients with a mental health condition
who are current smokers

4.3d

Number of active patients with a mental health condition
who drink alcohol

Number

Please note: not all patients included in the PIP QI reports will have a mental health condition. You can
produce reports from CAT4 to include just mental health condition patients.
Reflection on Activity 4.3:

Practice name:

Date:

Team member:
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Activity 4.4 – Understanding your practice alcohol and smoking status
The aim of this activity is to increase your understanding of the patient’s alcohol and smoking status.

Description

Status

Action to be Taken

After completing activity 4.3, are
there any unexpected results with
your practice’s patient alcohol and
smoking status?

 Yes: see actions to be taken.

Please explain: (e.g. high number of
patients with a mental health
condition who drink alcohol).

 No: continue with activity.

How will this information be
communicated to the practice team?

Do all clinicians know how to enter
alcohol and smoking status in your
practice’s clinical software?

 Yes: continue with activity.

After reviewing your data on
alcohol and smoking status, are
there any changes you would like
to implement in the practice, to
help using practice software, over
the next 12 months?

 Yes: see actions to be taken
to help set you goals.

See instructions on how to enter
into Medical Director or Best
Practice.

 No: see action to be taken.

 No: you have completed this
activity.

Refer to the Model for
Improvement (MFI) and the
Thinking part at the end of this
document.
Refer to the Doing part - PDSA of the
Model for Improvement (MFI) to
test and measure your ideas for
success.

Reflection on Activity 4.4:

Practice name:

Date:

Team member:
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Instructions for entering alcohol and smoking status in Best Practice
1. While the patient file is open, select Open > Alcohol & smoking history

2. Select Tobacco on the left-hand side menu.
3. Once you have entered the information, select Alcohol.
4. Select Save to complete.

Instructions on entering alcohol and smoking status into Medical Director
1. Open the patient file.

2.

From the ‘Patient’ menu select ‘Details’.

3. This will open a screen where you can enter patient details, allergy/reactions, family/social history, smoking,
alcohol and personal details.
4. Select Smoking.

5. Once you have entered the details, select Alcohol.
6. Once all details have been completed select Save.
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Weight, BMI and other risk factors
Sometimes people feel down or anxious about their weight. They may feel guilty for not being healthy and energetic.
They may blame themselves for not being fit and active. As well, if a person has depression or anxiety, their appetite,
energy levels, self-esteem and weight can all be affected.8

Activity 4.5 – Data Collection from CAT4
Complete the below table by collecting data from your PIP QI measures from your practice monthly
benchmark report.

The aim of this activity is to collect data to determine the number of patients with their BMI recorded as overweight or
obese
Description

Percentage

4.5a

Number of active patients aged 15+ years who have a BMI
recorded as ‘overweight’ in the previous 12 months

4.5b

Number of active patients aged 15+ years who have a BMI
recorded as ‘obese’ in the previous 12 months

Please note: not all patients included in these reports will have a mental health condition. You can complete
a search on CAT4 to include just patients with a mental health condition.
Reflection on Activity 4.5:

Practice name:

Date:

Team member:

8

http://healthyweight.health.gov.au/wps/portal/Home/keep-in-check/managing%20the%20challenges/mental-health-andweight/!ut/p/a0/04_Sj9CPykssy0xPLMnMz0vMAfGjzOI9jFxdDY1MDD3dzbycDTzNLfwsfP0MjYJNTfULsh0VAUgJjsw!/
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Activity 4.6 - Recording weight and risk factors in your clinical software

Description
Are all the risk factors being
recorded in the correct fields in
your clinical software? (e.g.: BP,
BMI, waist circumference etc,)

Status

Action to be taken

 Yes: you have completed this
activity.

Review how and where your risk
factor information is being
recorded in your practice software.

 No, see action to be taken.

See instructions on entering
information in Best Practice.

See instructions on entering
information in Medical Director.

Ensure all relevant team members
are aware of how to record risk
factor information.

Document in practice policy.

Reflection on Activity 4.6:

Practice name:

Date:

Team member:
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Instructions on entering measurements into Best Practice
1. Open the patients file.
2. From the top menu, select Clinical > Observations

3. Enter the appropriate information.

4. Click Save to complete.

Instructions on entering measurements into Medical Director
1. Open the patient file.
2. From the top menu select Tools > Tool Box > Tool Box

Brisbane South PHN
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3. Select the appropriate tab and enter the relevant information.

4. Click Save to complete.
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Activity 5. Medicare item numbers for patients with a
mental health condition
Patients with a mental health condition may be eligible to access item numbers within the Medicare Benefit Schedule
(MBS). These are dependent on patient age, ethnicity and co-morbidities. Conditions apply to each item number;
please ensure the GP understands these prior to claiming the item number/s. Brisbane South PHN has a
comprehensive toolkit looking at MBS items. Item numbers include:

Better access to psychiatrists, psychologists and general practitioners through
the MBS (Better Access) initiative
The purpose of the Better Access initiative is to improve the treatment and management of mental illness within the
community. The Better Access initiative is increasing community access to mental health professionals and teambased mental health care, with general practitioners encouraged to work more closely and collaboratively with
psychiatrists, clinical psychologists, registered psychologists and appropriately trained social workers and occupational
therapists. Part of the Better Access funding has been allocated to education and training for health professionals.

Education and training
As GPs are often the first point of contact for patients experiencing a mental illness, they are the most common
providers of mental health services. Therefore, it is essential that they have the necessary skills and knowledge to
address patients’ mental health needs.
The training accredited by the GPMHSC provides the fundamental skills required to assess a patient’s needs,
recommend appropriate referral options and manage a patient’s ongoing mental health care.

Mental health consultation (item 2713)
The GP mental health treatment consultation item is for an extended consultation with a patient where the primary
treating problem is related to a mental illness including for a patient being managed under a GP Mental Health
Treatment Plan. This item may be used for ongoing management of a patient with a mental health condition. This item
should not be used for the development of a GP Mental Health Treatment Plan.
A GP mental health treatment consultation must include:
•

taking relevant history and identifying the patient's presenting problem(s) (if not previously documented)

•

providing treatment, advice and/or referral for other services or treatment

•

documenting the outcomes of the consultation in the patient's medical records and other relevant mental
health plan (where applicable).

A patient may be referred from a GP mental health treatment consultation for other treatment and services as per
normal GP referral arrangements. This does not include referral for Medicare rebateable services for focussed
psychological strategy services, clinical psychology or other allied mental health services, unless the patient is being
managed by the GP under a GP Mental Health Treatment Plan.
Consultations associated with this item must be at least 20 minutes duration. There are no limits to the amount of
times this item number is claimed.
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Mental Health treatment plan (MBS item 2700, 2701, 2715 or 2717)
GPs providing mental health treatment plans, and who have undertaken mental health skills training recognised
through the General Practice Mental Health Standards Collaboration, have access to items 2715 and 2717.
Item Description

Medicare Criteria

Frequency of claiming

Mental health plan MBS Items 2700,
2701, 2715 or 2717)

A mental health disorder is a term
used to describe a range of clinically
diagnosable disorders that
significantly interfere with an
individual's cognitive, emotional or
social abilities.

A new plan may be completed after
12 months if clinically required and if
the person meets the eligibility
criteria.

The mental health plan must
include:
•
documenting the results of
assessment, patient needs,
goals and actions, referrals
and required
treatment/services
•
review date.

After the plan has been completed,
the patient is entitled to up to 10
Medicare subsidised visits (6 visits
initially, another 4 after a review)
with a Psychologist per calendar
year. Full details of the criteria can
be found here.

More information is available at Education guide for Mental Health Care

Mental health treatment plan review (MBS item 2712)
The review item is a key component for assessing and managing the patient's progress once a GP mental health
treatment plan has been prepared, along with ongoing management through the GP mental health treatment
consultation item and/or standard consultation items. A patient's GP mental health treatment plan should be
reviewed at least once.
A rebate can be claimed once the GP who prepared the patient's GP mental health treatment plan (or another GP in
the same practice or in another practice where the patient has changed practices) has undertaken a systematic review
of the patient's progress against the GP mental health treatment plan.
The review must include:
•

recording the patient's agreement for this service

•

a review of the patient's progress against the goals outlined in the GP mental health treatment plan

•

modification of the documented GP mental health treatment plan if required

•

checking, reinforcing and expanding education

•

a plan for crisis intervention and/or for relapse prevention, if appropriate and if not previously provided

•

re-administration of the outcome measurement tool used in the assessment stage, except where considered
clinically inappropriate.

A mental health plan review can be claimed every 3 months or at least 4 weeks after claiming the mental health plan
item number.
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Clinical psychologist (MBS items 80000 to 80021)
The Better Access to Psychiatrists, Psychologists and General Practitioners through the Medicare Benefits Schedule
initiative commenced on 1 November 2006. Under the Better Access initiative, MBS items provide Medicare benefits
for the following allied mental health services:
AHP Group
Clinical
Psychologist
(see also
Psychologist)

Item
Number
80000
80005
80010
80015
80020

Service
Provided
Psychological
therapy
Service

Eligible Patients

Prerequisite for Claiming

Patients with an
assessed mental
health disorder

GP mental health care plan, referral for
psychiatric assessment management plan (item
291), and/or relevant psychiatrist or paediatrician
item must have been claimed.

More information can be found at the MBS.

Mental health conditions and medication reviews (MBS item 900)
People with mental health conditions may be on medications and particularly those with other chronic diseases or
who are elderly may be polypharmacy.
•

GPs may be able to claim a Medicare item number to complete a Home Medication Review in conjunction with a
community pharmacist. Updates on the Medicare Benefit Schedule (MBS) item numbers, including fees and item
number criteria, are available at MBS Online.

Aboriginal and Torres Strait Islander health assessment (MBS 715) (if relevant)
The Aboriginal and Torres Strait Islander people’s health assessment is available to:
•

children between ages of 0 and 14 years

•

adults between the ages of 15 and 54 years,

•

older people over the age of 55 years.

See MBS descriptor for more information

Mental health conditions and health assessments (MBS item 701-707)
Some patients with a mental health condition may be eligible for a health assessment. A health assessment is the
evaluation of an eligible patient’s health and wellbeing. General practitioners use it to help decide if a patient needs:
•

preventive health care

•

education to improve their health and wellbeing

•

appropriate interventions.

There are also time-based MBS health assessment items: 701 (brief), 703 (standard), 705 (long) and 707 (prolonged).
If you are a non-vocationally registered GP, the following item numbers can be claimed: 224 (brief), 225 (standard),
226(long) and 227 (prolonged).
More information is available from MBS.
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Activity 5.1 – Checklist for reflection on MBS claiming
Complete the checklist below to review your practice’s MBS claiming for patients with a mental health
condition.
Description

Status

Are there any patients with a
mental health condition without
a mental health treatment plan
completed in the past 12
months? See activity 1.1

 Yes, see action to be taken.

Are there any patients with
mental health conditions who
may benefit from a Home
Medication Review? See activity
1.1. (note: not all patients with
mental health will be eligible for a
HMR, refer to MBS criteria).

 Yes, see action to be taken.

Action to be taken
Please explain.

 No, continue with the activity.

What action will you take?

Please explain.

 No, continue with the activity.

What action will you take?

How will you use this information
to increase the number of Home
Medication Reviews completed?

Have you created a TopBar
prompt on all patients with
mental health conditions who
may be eligible for a mental
health treatment Plan?

 Yes: continue with activity.

Do relevant staff know where to
find appropriate templates for
mental health treatment plans?

 Yes, continue with the activity.

Follow the instructions to complete
this.

 No: see actions to be taken.

See templates available here for
Best Practice and Medical Director.

 No, see actions to be taken.
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Description
Do relevant staff know what the
criteria is for completing Mental
Health treatment plans, Home
Medication Reviews and Health
Assessments through Medicare?

Status
 Yes, continue with the activity.

Action to be taken
Refer to MBS criteria at:
Mental Health treatment plans

 No, see actions to be taken.

Home Medication Review Criteria
Health Assessments

Does the practice have a system
for tracking Medicare item
number claiming?

 Yes, continue with the activity.
 No, see actions to be taken.

Do GPs have access to their day
sheets to identify MBS item
numbers claimed?

Does the practice nurse check that
any assessments completed have
the correct billing?

Are item numbers checked against
appointment diary prior to
batching?
Do you know the contact details
for any MBS related questions?

 Yes, continue with the activity.

 No, see actions to be taken.

Do relevant staff know that
Medicare provides online training
modules?

 Yes, continue with the activity.

After reviewing the MBS claiming
for patients with a mental health
condition, are there any changes
you would like to implement in
the practice to help manage
patients over the next 12
months?

 Yes, see actions to be taken.

Brisbane South PHN

 No, see actions to be taken.

Email: askMBS@health.gov.au
Provider Enquiry Line - 13 21 50

More information can be obtained
from Medicare Australia e-learning
modules.

Refer to the Model for
Improvement (MFI) and the
Thinking part at the end of this
 No, you have completed this activity. document.
Refer to the Doing part - PDSA of
the Model for Improvement (MFI)
to test and measure your ideas for
success.
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Reflection on Activity 5.1:

Practice name:

Date:

Team member:

Activity 5.2 – Data collection - MBS claiming for mental health patients
The aim of this activity is to review your practice’s claiming of MBS items for patients with mental health
conditions.
Note – Information to complete this activity is available from your latest benchmark report from Brisbane
South PHN.
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Description

Number

5.2a

Number of patients with a mental health condition

5.2b

Number of patients with a mental health condition and a MH
consult claimed

5.2c

Number of patients with a mental health condition and a MH
treatment plan claimed

5.2d

Number of patients with a mental health condition and a MH
treatment plan review claimed

Percentage

Reflection on Activity 5.2:

Practice name:

Date:

Team member:
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Activity 5.3– Review chronic disease management claiming for mental health patients
The aim of this activity is to review your Medicare item number claiming for patients with mental health
conditions.
Description
After completing activity 5.2,
are there any unexpected
results with your practice’s
claiming for mental health
patients?

Status
 Yes: see actions to be taken.

 No: continue with activity.

Action to be taken
Please explain: (e.g. low % of patients
with a MH treatment plan or we are
doing well at claiming MH treatment
plan reviews).

How will this information be
communicated to the practice team?

Is your practice claiming for
mental health patients similar
to other practices in the
Brisbane South region (compare
information from Benchmark
report)?

 Yes: continue with activity.

 No: see actions to be taken.

Outline the differences – (e.g. our
practice is lower at claiming mental
health consultations than other
practices).

How will this information be
communicated to the practice team?

After reviewing your claiming
for mental health patients, are
there any changes you would
like to implement in the
practice, to help manage
patients, over the next 12
months?

Brisbane South PHN

 Yes: see actions to be taken.

 No: you have completed this
activity.
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Reflection on Activity 5.3:

Practice name:

Date:

Team member:

Instructions for completing mental health treatment plan in Best Practice
1. Open the patient file.

2. Select Correspondence out.
3. Select Add > New document.
4. You should then be able to identify and select the appropriate mental health treatment plan.

5. Complete the plan, then Save to complete.
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Instructions for completing mental health treatment plan in Medical Director
1. Open the patient file.
2. Select Letters from the menu bar.

3. Select the + to start a new template.
4. Then click File > New.
5. You should then be able to select GP Mental Health Treatment Plan (either Adult or child).
6. Complete the plan, then Save to complete.
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Activity 6. Mental health conditions and suicide
Suicide in the Brisbane south region
The Brisbane South PHN Needs Assessment 2018 identifies mental health, suicide prevention, and alcohol and other
drugs as being high contributors to poor health in Brisbane south and a priority for action for the Brisbane South PHN.9

As the first point of contact for many people, GPs and their practices are at the frontline in working with people who
have considered or attempted suicide.
GPs should be alert for higher-risk individuals and the possibility of suicide.
People who are contemplating suicide will often give some clues or signs to those around them, including friends,
family, colleagues, their GP or other mental health professionals.10 Preventing suicide starts with recognising and
acting on warning signs, which usually occur in combination, and being aware of the specific risk factors involved. It
should be noted, however, that in some cases there might not be any warning signs.

Who is at increased risk?
A patient has increased risk of suicide if they:
•

have a history of mental illness (particularly mood disorders, alcohol and drug abuse)

•

have made previous suicide attempts or deliberate self-harmed

•

are male

•

are younger or older

•

have experienced recent loss or other adverse event

•

have a family history of attempted or completed suicide

•

have an ATSI background

•

are widowed

•

live alone or in prison

•

have a chronic and terminal illness

•

are up to 12 months post-discharge from a psychiatric hospital

•

are women experiencing intimate partner violence

•

identify as LGBTQI.

9

https://bsphn.org.au/wp-content/uploads/2019/03/Brisbane-South-Mental-Health-Suicide-Prevention-and-Alcohol-and-OtherDrug-MHSPAOD-Strategy-2019-2022.pdf
10
https://www.healthdirect.gov.au/warning-signs-of-suicide
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Suicide risk factors
For those at higher risk, it is important to be aware of and evaluate the risk factors for suicide.
•

Assessment of suicide risk involves enquiring into the extent of suicidal thinking and intent. This includes
assessing the following: suicidal thinking (if present, how frequent and how persistent?), planning (if present,
how detailed and realistic is it?), lethality (what method has been chosen and how lethal is it?), means (does
the person have the means to carry out the method?), past history (has the person ever planned or attempted
suicide?), history of suicide of family member or peer.

•

Also consider: guilt, impulsivity, substance use, strengths and supports

•

For all people with suicidal ideation, enquiry should be made about preparatory activities e.g. obtaining a
weapon, making a plan, putting affairs in order, giving away possessions, preparing a note etc.

•

In young people, the HEADS ED tool has questions that can assist in assessing suicide risk.

For example:
•

Sometimes when people feel really down, they feel like hurting or even killing themselves.

•

They can deliberately harm or injure themselves (e.g. cutting, burning or putting them self in unsafe situations,
such as unsafe sex).

•

People can lose interest in things they usually enjoy.

GP involvement in suicide assessment
Research shows that quality mental health care can reduce suicidal thinking and prevent suicidal behaviour. It is
important that clinicians are equipped with skills to discuss suicide and suicide risk with their patients. This involves a
comprehensive psychosocial assessment and assessment of suicidality.11

Responding to suicide risk
It is important that clinicians are equipped to discuss and develop a suicide safety plan. Safety planning has been
shown to reduce suicide risk and increase engagement with health services when used in combination with evidencebased therapy. It is important to involve the patient in treatment planning and to have a recovery-oriented focus. For
people at a high and immediate risk of suicide, it is important that GPs and practice staff are aware of where to access
immediate assistance if required. This may involve the local hospital or acute mental health service. Occasionally, for
those at immediate danger to themselves or others, this may require calling 000 and using the Mental Health Act.

11

https://www.racgp.org.au/clinical-resources/clinical-guidelines/key-racgp-guidelines/view-all-racgp-guidelines/redbook/psychosocial/suicide
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Activity 6.1– Suicide prevention in general practice
The aim of this activity is to review your practice’s role in suicide prevention.

Description

Status

Does your practice undertake
health promotion and activities
for mental health and suicide
prevention?

 Yes: continue with activity.

Are clinical staff trained in how
to conduct a suicide risk
assessment?

 Yes: continue with activity.

 No: see actions to be taken.

Action to be taken
Consider running a series of
promotional events in the practice
coinciding with World Mental Health
Day.

Consider extra training in mental
health first aid.

 No: see actions to be taken.

Are clinicians trained in how to
develop a suicide safety plan?

 Yes: continue with activity.

More information available from
Beyond Blue.

 No: see actions to be taken.
Suicide safety planning app.

Are staff trained in how to
respond to a mental health
emergency?

 Yes: continue with activity.

Consider extra training in mental
health first aid.

 No: see actions to be taken.
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Description
Are patients provided with
mental health and suicide
prevention resources in other
languages and for Aboriginal
communities?

Status
 Yes: continue with activity.

 No: see actions to be taken.

Action to be taken
Ensure the practice has a number of
mental health and suicide prevention
resources available in the waiting room
and GP consultation rooms.
Resources available from:
Head to health
Beyond Blue

After reviewing your suicide
prevention strategies, are there
any changes you would like to
implement in the practice, to
help manage patients, over the
next 12 months?

 Yes: see actions to be taken.

 No: you have completed this
activity.

Refer to the Model for Improvement
(MFI) and the Thinking part at the end
of this document.
Refer to the Doing part - PDSA of the
Model for Improvement (MFI) to test
and measure your ideas for success.

Reflection on Activity 6.1:

Practice name:

Date:

Team member:
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Activity 7. Establishing appropriate care assessments and
pathways using evidence-based guidelines
Activity 7.1 – Assessments to assist with identifying mental health patients
Screening tools and standardised measures are commonly used to assess patients who may be at risk of a mental
health condition. They can identify motivation, dependence, mental health status, quality of life and patient risk.
Some may also assist clinicians to effectively monitor client progress over time (outcomes). Standardised measures
should supplement an assessment process, not replace it.
These screening and assessment tools are commonly used:
•

Alcohol Use Disorders Identification Test (AUDIT)

•

DASS 21 (Depression, Anxiety, Stress Scales)

•

DASS 42 (Depression, Anxiety, Stress Scales)

•

Kessler 5 (K5)

•

Kessler 10 (K-10)

•

Severity of Dependence Scale

•

Indigenous Risk Impact Screen (IRIS)

•

Substance and Choices Scale (for ages 13-18)

•

Mental State Examination

•

Fagerstrom Nicotine Tolerance Questionnaire

•

Psycheck

•

Alcohol, Smoking and Substance Involvement Screening Test (ASSIST)

•

Edinburgh Postnatal Depression Scale

•

Geriatric Depression Scale

•

Montreal Cognitive Assessment

•

Paediatric symptom checklist

•

HEADSS – for adolescents

•

HoNOS and Life skills profile
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Instructions on completing screening tools on Best Practice
1. Open the patient file.
2. From the top menu select Clinical.

3. Select the appropriate assessment and complete.

Instructions on completing screening tools on Medical Director
1. Open the patient file.
2. From the top menu, select Assessments.

3. Select the appropriate assessment and complete.
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Identify roles for managing mental health patients within your practice
Consider how best to use your practice staff to provide optimum care and the impact this will have on the workload
and appointment system. This involves systematically determining if your practice is set up and equipped to provide
evidence-based mental health assessment and management.
Activity

Nurse

GP

Complete appropriate screening tool (for e.g. K10 or MMSE etc).
Organise investigations (if relevant).
Monitor blood pressure.
Height, weight & BMI.
Complete cardiovascular risk assessment.
Update patient reminders for regular monitoring (frequency depends on
patients’ condition).
Review diet/healthy eating.
Review physical activity and exercise tolerance.
Review smoking & alcohol intake.
Review substance and drug use.
Offer support services.
Provide self-care education.
Mental health assessment.
Consider comorbidities (CKD, diabetes,
cardiovascular disease, lung cancer).
Review medications.
Complete mental health treatment plan and review.
Home Medication Review (if appropriate).
Assess need for referral to other mental health provider.
Consider advanced care planning.
Complete suicide risk assessment.
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Reflection on Activity 7.1:

Practice name:

Date:

Team member:
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Activity 8. Recalls and reminders
As part of the RACGP accreditation standards, it is a requirement that practices provide health promotion, illness
prevention, preventive care and a reminder system based on patient need and best available evidence.

Reminders, recalls and prompts (flags)
Reminders are used to initiate prevention, before or during the patient visit. They can be either opportunistic or
proactive. Recalls are a proactive follow up to a preventive or clinical activity. Prompts are usually computer
generated, and designed to opportunistically draw attention during the consultation to a prevention or clinical activity
needed by the patient. Using a recall system can seem complex, but there are steps you can take:
•

be clear about when and how you want to use these flags

•

explore systems used by other practices, your PHN, and information technology specialists to ensure you get
the correct system

•

identify all the people who need to be recalled and place them in a practice register to help to ensure the
recall process is systematic and complete

•

ensure that patient consent is obtained prior to including them in the practice reminder system

Some examples specific to mental health conditions may include: review of GP mental health plan due, medication
monitoring due, depot injection due etc.

Train IT Medical – recall and reminder resources for Medical Director
Train IT Medical have a number of resources available for practices to use to assist managing their recall and reminder
systems. These include:
•

Sample Recall Management Protocol/FlowchartMedicalDirector learning resources

•

Sample Quality Improvement Activity

•

Train IT Medical ‘Recalls, Reminders & Screening’ using MD Presentation

•

Read our MedicalDirector Clinical Top 5 ‘Recalls & Reminders’ Tips

Train IT Medical – recall and reminder resources for Best Practice
Train IT Medical have a number of resources available for practices to use to assist managing their recall and reminder
systems. These include:
•

Reminders quick reference guide

•

Creating a reminder template

•

Sending SMS reminders to patients

•

Recall & reminders – why it’s so hard
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Activity 8.1 – Reminder system
Status
Does your practice have a routine reminder
for appropriate mental health follow up?

Action to be taken

 Yes, continue with activity. For instructions on creating a
reminder in Best Practice.
For instructions on creating a
reminder in Medical Director.

 No, see action to be
taken.
Is consent obtained from patients to be
 Yes, how is this done?
included in the practice’s reminder system?

Include a section on new patient
information sheet about consent to
participate in reminder system.

 No, see action to be
taken.

Clinicians ask patients prior to
placing them on reminder system.
How does the practice record if a patient
DOES NOT wish to be contacted offering
reminder appointments?
Do clinicians know how to initiate a patient
reminder within clinical software?

 Yes, continue with activity. Clinician education on setting up
patient reminders.
 No, see action to be
taken.

How regularly are reminder lists generated
for each doctor/nurse?

Doctor

Practice
nurse

Create a practice policy for
frequency of generating lists.
Nominate a practice member to
generate reminder lists.

Is there a system for reviewing and
actioning reminder lists? i.e.
•
•
•
•

all posted
all telephoned
wait for patient to attend
GPs review lists and classifies
reminders.

Is there a system to identify in the
appointment book when a patient is
coming in for a reminder appointment?

Brisbane South PHN

 Yes, continue with activity. Create policy for activating
reminders due.
 No, see action to be
taken.

Nominate a practice member to
activate reminders due.

 Yes, continue with activity. Use of a symbol in the appointment
book to identify type of
 No, see action to be
appointment.
taken.
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Status

Action to be taken

Is there a process for acting on or removing
outstanding reminders? E.g. patients fail to
attend, reminder no longer needed.

 Yes, continue with activity. GP education on removing
reminders.
 No, see action to be
taken.

Document practice process on
removing reminders.

Is there a practice policy on how reminders
are to be implemented? E.g. entering all
reminders for the upcoming 12 months to
ensure all tests are performed?

 Yes, policy is working.

Revise policy.

 Yes, policy is not working,
see action to be taken.

Practice policy on reminders to be
implemented.

Is there a system for ensuring patients
recently diagnosed with a mental health
condition are incorporated into the
reminder system?

 Yes, policy is working.

Revise policy.

 Yes, policy is not working,
see action to be taken.

Practice policy on reminders to be
implemented.

After reviewing your practice recall and
reminder system, are there any changes
you would like to implement in the practice,
to help manage patients, over the next 12
months?

 Yes, see actions to be
taken.

 No policy, see action to be
taken.

 No policy, see action to be
taken.

 No, you have completed
this activity.

Refer to the Model for
Improvement (MFI) and the
Thinking part at the end of this
document.

Refer to the Doing part - PDSA of the
Model for Improvement (MFI) to
test and measure your ideas for
success.

Reflection on Activity 8.1:

Practice name:

Date:

Team member:
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Creating reminder category for monitoring mental health in Best Practice
To create a reminder category for monitoring patients with mental health in Best Practice: (please note: always check
the reminder list prior to creating a category as it may already be included)
1.

Select Setup > Configuration from the main Best Practice screen.

2. Scroll down on the left-hand side to find the Reminders icon.
3. The top section of the screen shows the Reminder
Reason list—this is the full list of reminder reasons
available when reminders are being created within
the patient record.
4. Choose Add.

5. Type in the reason as appropriate (e.g. mental
health review) and then the interval.
6. Click Save > Save

Creating reminder category for monitoring mental health in Medical Director
To create a reminder category for monitoring mental health
patients in Medical Director: (please note: always check the
reminder list prior to creating a category as it may already be
included)
1.

Select Tools > Options.

2. Select the Recall tab. The list of recall reasons is
presented.
3. Select Add.
4. Enter a Name/description for the recall reason you
wish to add.
5. Modify other settings as desired: note that these
settings are simply the defaults for this recall reason,
which can be overridden when you go to create a new
recall for the patient.
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o Recall Interval: How often the recall should occur, when it is used for recurring recalls (as opposed to
once-off recalls)
o Gender Restriction: Whether the recall reason's availability is limited to a specific gender
o Age Range Restriction: Whether the recall reason's availability is limited to a specific age group.
6. Click Save to confirm. You will be returned to the Recall tab, where your new recall reason is now listed.
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Activity 9. Referral pathways
The aim of this activity is to ensure that practice staff have access to the relevant information and understand pathways
for referral of patients to specialists and allied health staff as deemed clinically appropriate.
Engaging other medical services (e.g. diagnostic services; hospitals and consultants; allied health; and social, disability,
financial, housing, training, supported employment, alcohol and drug treatment and community services) assist the
practice to provide optimal care to patients whose health needs require integration with other services.
Multidisciplinary teams convey many benefits to both service users and the mental health professionals working on
the team, such as continuity of care, the ability to take a comprehensive, holistic view of the service user’s needs, the
availability of a range of skills, and mutual support and education.12

Potential members of the multidisciplinary mental health team

12

https://www.researchgate.net/publication/260125071_Interdisciplinary_Care_to_Enhance_Mental_Health_and_Social_and_Emo
tional_Wellbeing
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Essential referral information for mental health patients
Metro South 24-hour phone support
The Metro South community can access local mental health services for information and assistance in times of mental
health crisis 24 hours a day via a centralised phone number:
Phone: 1300 MH CALL (1300 64 22 55)

Refer your patient
Metro South Health is the major provider of public health services, and health education and research, in the Brisbane
south side, Logan, Redlands and Scenic Rim regions. The refer your patient website assists health professionals with
accessing public health services for patients. It provides a single point of entry for all new referrals.
The website outlines available health professionals, criteria to access appointments with the health professionals and
expected wait times as well as all the information required in the referral.

Metro South Health provides a number of services to patients with a variety of mental health conditions.

Under each section, referral requirements are listed to assist with the smooth transition of care. This is an example of
the requirements of older people mental health:
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More information about referral criteria can be found at Metro South Health

SpotOnHealth HealthPathways
SpotOnHealth HealthPathways provides clinicians in the greater Brisbane south catchment with web-based
information outlining the assessment, management and referral to other clinicians for more than 550 conditions.
It is designed to be used at point of care primarily by general practitioners but is also available to specialists, nurses,
allied health and other health professionals.
To access SpotOnHealth HealthPathways you will need to log in.

Primary mental health and wellbeing initiatives
Brisbane South PHN commissions mental health, suicide prevention, and alcohol and other drug services designed to
provide flexible support that is best suited to an individual’s needs. There are three sub-regions:
•

Brisbane (Princess Alexandra Hospital catchment area)

•

Logan/Beaudesert (Logan Hospital catchment area)

•

Redlands (Redlands Hospital catchment area)

Assistance is available for GPs to link to Brisbane South PHN commissioned mental health services.

Health Services Directory
Health Services Directory is a joint initiative of all Australian governments, delivered by HealthDirect Australia, to provide
health professionals and consumers with access to reliable and consistent information about health services.
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My Community Directory
My Community Directory lists organisations that provide services that are free or subsidised to the public in thousands
of locations across Australia. These services are organised into various Community Directories.

Other services
If you can’t find a service that suits your needs, these links may help:
•

Alcohol and Drug Information Service

•

Ask Izzy

•

Head to Health

•

Lifeline

•

Metro South Health

•

Suicide Call Back Service

Activity 9.1 – Referral Pathways
Complete the checklist below in relation to referral pathways.
This activity is designed to raise your awareness of local referral options available for you and your patients to facilitate
co-ordinated and therefore optimal care.
Status
Do all GPs and Nurses
have login details for
SpotOnHealth
HealthPathways?

 Yes, continue with
the activity.

Do all GPs and Nurses
know how to access
SpotOnHealth
HealthPathways via
Topbar?

 Yes, continue with
the activity.

Brisbane South PHN

Action to be taken
Register on the login page to request access.

 No, see Action to be
taken.

 No, see Action to be
taken.

See instructions.
Or
contact BSPHN Digital Health Team via email:
ehealth@bsphn.org.au.
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Status

Action to be taken

Do all GPs and Nurses
know how to refer to
Brisbane South PHN
commissioned mental
health, suicide
prevention and alcohol
and other drug
services?

 Yes, continue with
the activity.

How will you
communicate
information so clinicians
know where to access
details on referring a
patient to specialist
services?

What is the practice plan for communicating referral information?

After reviewing your
practice referral system,
are there any changes
you would like to
implement in the
practice, to help manage
patients, over the next
12 months?

 Yes, see actions to be Refer to the Model for Improvement (MFI) and the
taken.
Thinking part at the end of this document.

Refer to Brisbane South PHN.

Refer to the FAQs page.
 No, see Action to be
taken.

 No, you have
completed this activity.

Refer to the Doing part - PDSA of the Model for
Improvement (MFI) to test and measure your ideas for
success.

Reflection on Activity 9.1:

Practice name:

Date:

Team member:
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Activity 10. Policy and procedures (including mental health
strategies)
It is important that the practice reviews its policy and procedure manual, to ensure relevant documentation is in place
and up to date. It is recommended that the following policy & procedures are in place:
•

anti-bullying in the workplace

•

support for staff when dealing with stressful situations

•

dealing with difficult patients

•

GP self-care

•

transfer of patient care

•

personal duress alarms

•

employee assistance program

•

patient’s rights and responsibilities

•

mental health first aid

•

triage – includes suicidal patients or those who have self-harmed

Activity 10.1 – Policies and Procedures
Complete the below table to gather information on your current policies and procedures relating to mental
health management.

Activity 10.1 – Review Policy & Procedures
Does the practice have a policy and
procedure for the following?

Policy up
to date *

Policy needs
reviewing

Anti-bulling in the workplace

□

□

Support for staff when dealing with
stressful situations

□

□

Dealing with difficult patients

□

□

GP self-care
(http://www.dhas.org.au/)

□

□

Transfer of patient care

□

□

Personal duress alarms

□

□

Employee assistance programs

□

□

Patient’s rights and responsibilities

□

□

Mental Health first aid

□

□

Triage – including suicidal or patients
who have self-harmed

□

□

Workplace and safety

□

□
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Reflection on Activity 10.1:

Practice name:

Date:

Team member:

Activity 10.2 – Policies and procedures review
The aim of this activity is to complete a PDSA on any policy and procedures that need updating in your
practice.
Description
After reviewing your relevant
policy and procedures, are there
any changes you would like to
implement in the practice, to
help manage patients, over the
next 12 months?

Status
 Yes: see actions to be taken.

 No: you have completed this
activity.

Action to be taken
Refer to the Model for Improvement
(MFI) and the Thinking part at the end
of this document.
Refer to the Doing part - PDSA of the
Model for Improvement (MFI) to test
and measure your ideas for success.

Reflection on Activity 10.2:

Practice name:

Date:

Team member:
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Activity 11. Resources and education
Mental health resources for health professionals
•

Mental health guidelines - RACGP

•

Keeping body and mind together – RANZCP

•

Clinical Guidelines for the Physical Care of Mental Health Consumers

•

Headspace clinical toolkit

•

Diagnostic and Statistical Manual of Mental Disorders, 5th edition – American Psychiatric association

•

SpotOnHealth HealthPathways

Education for health professionals
•

Mental health skills training – ThinkGP

•

Insight training

•

Mental health CPD for nurses

•

RACGP e-learning modules

•

Brisbane South PHN Education events

•

National Prescribing Service - You can find a number of resources focused on mental health conditions.
Specific resources of interest to health professionals may include:
o

MedicineWise News

o Clinical eAudit
o

Online case study

•

Mental health first aid – there are a number of accredited courses available to complete this

•

Managing Physical Health in Severe Mental Illness - RACGP

Resources for patients
•

Sane Australia

•

Beyond Blue

•

Black Dog Institute

•

Lifeline

•

Suicide Call Back Service

•

Head to health

•

Alcohol and Drug information services

Resources for Aboriginal and Torres Strait Islander patients
•

Family support and healing -Queensland health

•

Beyond Blue

•

Head to health
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Quality improvement activities using the model for improvement and PDSA
After completing any of the workbook activities above you may identify areas for improvement in the management of
patients with a mental health condition. Follow these steps to conduct a quality improvement activity using The Model
for Improvement and PDSA. The model consists of two parts that are of equal importance.
Step 1: The ‘thinking’ part consists of three fundamental questions that are essential for guiding improvement work:
• What are we trying to accomplish?
• How will we know that the proposed change will be an improvement?
• What changes can we make that will lead to an improvement?
Step 2: The ‘doing’ part is made up of Plan, Do, Study, Act (PDSA) cycles that will help to bring about rapid change. This
includes:
• Helping you test the ideas.
• Helping you assess whether you are achieving your desired objectives.
• Enabling you to confirm which changes you want to adopt permanently.
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Model for improvement and PDSA worksheet EXAMPLE
Step 1: The Thinking Part - The 3 Fundamental Questions
Practice name:
Date:
Team member:
Q1. What are we trying to accomplish?
(Goal)
By answering this question, you will develop your goal for improvement
Our goal is to:
• Ensure all patients with a mental health diagnosis have their alcohol consumption
recorded.
This is a good start, but how will you measure whether you have achieved this goal? The
team will be more likely to embrace change if the goal is more specific and has a time limit.
So, for this example, a better goal statement would be:
Our S.M.A.R.T. goal is to:
• Increase the percentage of alcohol consumption recorded on all active patients aged 15 years and older
with an active mental health condition by 10% by 31 July.
Q2. How will you know that a change is an improvement?
(Measure)
By answering this question, you will develop MEASURES to track the achievement of your goal.
E.g. Track baseline measurement and compare results at the end of the improvement.
We will measure the percentage of active patients who have their alcohol consumption recorded. To do this
we will:
A) Identify the number of active patients aged 15 years and older with an active mental health
condition.
B) Identify the number of active patients aged 15 years and older who have had their alcohol
consumption recorded.
B divided by A x 100 produces the percentage of patients who have had their alcohol consumption recorded.
Q3. What changes could we make that will lead to an improvement?
(List your IDEAS)
By answering this question, you will develop the IDEAS that you can test to achieve your CHANGE goal.
You may wish to BRAINSTORM ideas with members of our practice team.
Our ideas for change:
1. Using CAT4, identify active patients aged 15 years and older who have not had alcohol consumption
recorded.
2. Identify patients from list exported from CAT4 and create a TopBar prompt.
3. Source and provide endorsed patient education resources (in waiting rooms, etc).
The team selects one idea to begin testing with a PDSA cycle.
Note: Each new GOAL (1st Fundamental Question) will require a new Model for Improvement Guide
Source: Langley, G., Nolan, K., Nolan, T., Norman, C. & Provost, L. 1996, The Improvement Guide, Jossey-Bass, San Francisco, USA.
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Model for Improvement and PDSA worksheet EXAMPLE
Step 2: The Doing Part - Plan, Do, Study, Act
You will have noted your IDEAS for testing when you answered the third Fundamental Question in Step 1
You will use this sheet to test an idea.
PLAN

Describe the brainstorm idea you are planning to work on.

(Idea)

Plan the test,
including a plan for
collecting data

What exactly will you do? Include what, who, when, where, predictions and data to be
collected.

Idea: Using CAT4, identify active patients aged 15 years and older with an active mental health condition who
have not had their alcohol consumption recorded.
What: Mary will conduct a search on CAT4.
Who: Receptionist (Mary)
When: Begin 20 May
Where: at the practice in Dr Brown’s room
Prediction: 40% of the active patient population with a mental health condition aged 15 years and older will have
an alcohol consumption recorded.
Data to be collected: Number of active patients 15 years and older with an active mental health condition and the
number of active patients 15 years and older who have not had an alcohol consumption recorded.
DO

Who is going to do what?

(Action)

Run the test on a
small scale

How will you measure the outcome of your change?

Completed 20 May – the receptionist contacted Brisbane South PHN for support with the PenCS CAT4 search and
the export function. The data search was conducted very quickly, with the receptionist being upskilled to conduct
further relevant searches.
STUDY

Does the data show a change?

(Reflection)

Analyse the results
and compare them
to your predictions

Was the plan executed successfully?
Did you encounter any problems or difficulty?

A total of 327 active patients (37%) 15 years and older have had their alcohol consumption recorded = 3% lower
than predicted.
Do you need to make changes to your original plan?

(What next)

ACT
OR Did everything go well?
Based on what you
learned from the
test, plan for your
next step

Brisbane South PHN

If this idea was successful you may like to implement this change on a larger scale or try
something new.
If the idea did not meet its overall goal, consider why not and identify what can be done to
improve performance.
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1.

Create a PenCS Topbar prompt to ensure all patients aged 15 years and older with an active mental health
condition to have alcohol consumption recorded. Review this by 31 July (in 2 months’ time) to determine if
there has been an increase in the % of patients recorded.

2.

Ensure the clinical team know how to enter alcohol consumption in the medical software.

3.

Remind the whole team that this is an area of focus for the practice.

Repeat Step 2 for other ideas – What idea will you test next?
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Model for Improvement and PDSA worksheet template

Step 1: The Thinking Part - The 3 Fundamental Questions
Practice name:

Date:

Team member:
Q1. What are we trying to accomplish?

(Goal)

By answering this question, you will develop your GOAL for improvement.

Q2. How will you know that a change is an improvement?

(Measure)

By answering this question, you will develop MEASURES to track the achievement of your goal.
E.g. Track baseline measurement and compare results at the end of the improvement.

3. What changes could we make that will lead to an improvement?

(List your IDEAS)

By answering this question, you will develop the IDEAS that you can test to achieve your CHANGE goal.
You may wish to BRAINSTORM ideas with members of our Practice Team.
Idea:

Idea:

Idea:

Idea:
Note: Each new GOAL (1st Fundamental Question) will require a new Model for Improvement plan.
Source: Langley, G., Nolan, K., Nolan, T., Norman, C. & Provost, L. 1996, The Improvement Guide, Jossey-Bass, San Francisco, USA.
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Model for Improvement and PDSA worksheet template

Step 2: The Doing Part - Plan, Do, Study, Act cycle
You will have noted your IDEAS for testing when you answered the third Fundamental Question in Step 1
You will use this sheet to test an idea.
PLAN

Describe the brainstorm idea you are planning to work on.

(Idea)

Plan the test,
including a plan for
collecting data.

What exactly will you do? Include what, who, when, where, predictions and data to be
collected.

DO

Who is going to do what?

Run the test on a
small scale.

How will you measure the outcome of your change?

STUDY

Does the data show a change?

Analyse the results
and compare them
to your predictions.

Was the plan executed successfully?

(Action)

(Reflection)

Did you encounter any problems or difficulties?

Do you need to make changes to your original plan?

(What next)

ACT
OR Did everything go well?
Based on what you
learned from the
test, plan for your
next step.

If this idea was successful you may like to implement this change on a larger scale or try
something new.
If the idea did not meet its overall goal, consider why not and identify what can be done
to improve performance.

Repeat Step 2 for other ideas - What idea will you test next?
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